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Frontispiece. Continued on next two pages.
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Frontispiece (continued). Caption on next page.
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Frontispiece (continued). (Figure shown on previous two pages.) 

A. Predicted bathymetry (after Smith and Sandwell, 1997) of the Ontong Java Plateau (outlined in red) showing the
locations of sites drilled during Leg 192 (stars). Previous Ocean Drilling Program (ODP) and Deep Sea Drilling Project drill
sites that reached basement are marked by black dots. White dots mark Site 288, which did not reach basement but
bottomed in Aptian limestone, and Site OJ-7, which was proposed for Leg 192 but not drilled. The bathymetric contour
interval is 1000 m.

B. Close-up photograph of a pillow margin from Site 1187 (interval 192-1187A-11R-1, 46–77 cm), showing an Fe
oxyhydroxide–stained spherulitic region parallel to the glassy rim. 

C. Photomicrograph showing elongate altered olivine crystals and spherulitic plagioclase crystals in a pillow margin from
Site 1185 (Sample 192-1185B-4R-1, 142–144 cm). Field of view = 5.5 mm; plane-polarized light. 

D. Unaltered olivine phenocrysts in basalt from a pillow center from Site 1187 (Sample 192-1187A-6R-6, 105–107 cm).
Field of view = 2.8 mm; crossed polars. 

E. Sprays of plagioclase and augite crystals in a massive flow interior from Site 1186 (Sample 192-1186A-34R-2, 143–146
cm). Field of view = 2.8 mm; crossed polars. 

F. Close-up photograph of a spherulitic, high-Mg basalt pillow margin from Site 1185 (interval 192-1185B-3R-1, 54–63
cm). The glassy rim of the pillow is at the lower right. 
G. Zr vs. TiO2 for basement rocks recovered at all Leg 192 sites and ODP Sites 803 and 807 (Mahoney et al., 1993). The
fields for the Kwaimbaita Formation and the overlying Singgalo Formation on Malaita (Tejada et al., 1996, 2001) are
shown for comparison. 

H. Close-up photograph of wood fragments in lithic vitric tuff near the base of Subunit IIE at Site 1184 (interval 192-
1184A-45R-7, 48–65 cm). 

I. Close-up photograph of accretionary lapilli, both whole (round) and fragmented, in gray lithic vitric tuff, Subunit IIA at
Site 1184 (interval 192-1184A-14R-1, 58–66 cm). 

J. Photomicrograph showing a wide range of lithic and vitric clast types present in a lithic vitric tuff from Subunit IID at
Site 1184 (Sample 192-1184A-31R-7, 40–43 cm). The clasts include glass shards (light brown), basalt (gray), and
tachylite (dark brown). Plane-polarized light.
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Smith, W.H.F., and Sandwell, D.T., 1997. Global seafloor topography from satellite altimetry and ship depth soundings. Science, 277:1956–1962.
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Tejada, M.L.G., Mahoney, J.J., Neal, C.R., Duncan, R.A., and Petterson, M.G., in press. Basement geochemistry and geochronology of central Malaita,

Solomon Islands, with implications for the origin and evolution of the Ontong Java Plateau. J. Petrol.
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Reference to the whole or to part of this volume should be made as follows: 

Print citation for Chapter 1:
Shipboard Scientific Party, 2001. Leg 192 summary. In Mahoney, J.J., Fitton, J.G., Wallace, P.J., et al., 
Proc. ODP, Init. Repts., 192: College Station TX (Ocean Drilling Program), 1–75.

CD-ROM volume citation:
Mahoney, J.J., Fitton, J.G., Wallace, P.J., et al., 2001. Proc. ODP, Init. Repts., 192 [CD-ROM]. Available 
from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2001. Site 1183. In Mahoney, J.J., Fitton, J.G., Wallace, P.J., et al., Proc. ODP, 
Init. Repts., 192, 1–169 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M University, 
College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.
The printing date of this volume: November 2001

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 188 (Initial Reports): March 2001
Volume 189 (Initial Reports): May 2001
Volume 190 (Initial Reports): July 2001
Volume 172 (Scientific Results): September 2001
Volume 173 (Scientific Results): August 2001
Volume 174B (Scientific Results): July 2001

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any corrections, revisions, or additions will be 
noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 

work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).
The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA (e-mail: database@odpemail.tamu.edu).

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

Some close-up photographs of very dark cores have been tonally enhanced to better illustrate 
particular features of interest.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover image is of close-up of interval 192-1185B-4R-1, 103–111 cm, by ODP Photographer Shannon 
Center. See Figure F51, p. 78, in the “Site 1185” chapter for a full description.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 

facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 15 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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CD-ROM CONTENTS: CHAPTERS

1. Leg 192 Summary
Shipboard Scientific Party
2. Explanatory Notes
Shipboard Scientific Party

3. Site 1183
Shipboard Scientific Party

4. Site 1184
Shipboard Scientific Party

5. Site 1185
Shipboard Scientific Party

6. Site 1186
Shipboard Scientific Party

7. Site 1187
Shipboard Scientific Party
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs); smear slide data tables; sediment, igneous, and volcaniclastic thin 
section data tables; digital core images; and digital photomicrograph images are included in this 
section. ASCII versions of the smear slide data tables are also available (see “ASCII Tables”).
Site 1183

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1184

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1185

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1186

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1187

Visual Core Descriptions · Smear Slides · Thin Sections 
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of coring summaries and selected biostratigraphy, chemistry, 
paleomagnetism, and physical properties data tables and all of the smear slide data tables presented 
under “Core Descriptions.” A complete listing of the ASCII data tables can be found on the next four 
pages. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, clicking on a filename with a .TXT extension will launch the Notepad application. You can 

configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98 systems: 
View > Folder Options > File Types.

MAC COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 3 Chapter 5 Chapter 7
Chapter 4 Chapter 6 Smear slide data tables
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Chapter 3, Site 1183
Table T1. Coring summary, Hole 1183A. 
Table T2. Expanded coring summary, Hole 1183A.
Table T5. Depth-age summary of Cretaceous stages and Cenozoic epochs, Hole 1183A.
Table T6. Summary of depths and estimated duration of unconformities, Hole 1183A.
Table T7. List of Cenozoic planktonic foraminifer and calcareous nannofossil lowest, highest, and 
highest common occurrences, Hole 1183A.

Table T8. List of Cretaceous planktonic foraminifer and calcareous nannofossil highest, lowest, and 
lowest common occurrences, Hole 1183A.

Table T11. Geochemical data for whole-rock samples analyzed by shipboard ICP-AES, Hole 1183A.
Table T13. Characteristic remanent magnetization direction, natural remanent magnetization, 
median destructive field, magnetic susceptibility, and Koenigsberger ratio for selected basalt 
pieces. 

Table T14. Index properties data, Hole 1183A.

Table T15. P-wave velocity measured using the contact probe system, Hole 1183A. 
Table T16. Thermal conductivity values, Hole 1183A.

Chapter 4, Site 1184
Table T1. Coring summary, Hole 1184A.
Table T2. Expanded coring summary, Site 1184.
Table T5. List of planktonic foraminifer and calcareous nannofossil highest and lowest occurrences in 
Unit I, Hole 1184A.

Table T7. Whole-rock compositions of six fine-grained bulk samples, Hole 1184A.
Table T9. Index properties data, Hole 1184A.
Table T10. P-wave velocity measured using the contact probe system.
Table T11. Thermal conductivity values, Hole 1184.

Chapter 5, Site 1185
Table T1. Coring summary, Site 1185.
Table T2. Expanded coring summary, Site 1185. 
Table T5. List of planktonic foraminifer and calcareous nannofossil highest and lowest occurrences in 
Unit I.
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Table T6. Range chart showing middle to upper Eocene turnover in abyssal benthic foraminifer 
assemblages.

Table T8. Shipboard ICP-AES analyses and normative compositions of basalt samples, Site 1185.
Table T9. Characteristic remanent magnetization direction, natural remanent magnetization 
intensity, median destructive field, magnetic susceptibility, and Koenigsberger ratio for selected 
basalt pieces, Site 1185. 

Table T10. Paleomagnetic units A1–A4 and B1–B18.
Table T12. Index properties data, Site 1185.
Table T13. P-wave velocity measured using the contact probe system, Site 1185. 
Table T14. Thermal conductivity values, Site 1185.

Chapter 6, Site 1186
Table T1. Coring summary, Hole 1186A.

Table T2. Expanded coring summary, Site 1186. 
Table T5. Summary of depths and estimated duration of unconformities, Hole 1186A.
Table T6. List of Cenozoic planktonic foraminifer and calcareous nannofossil highest occurrences and 
lowest occurrences, Hole 1186A.

Table T7. List of Cretaceous planktonic foraminifer and calcareous nannofossil highest and lowest 
occurrences, Hole 1186A.

Table T8. Geochemical data for whole-rock samples analyzed by shipboard ICP-AES, Hole 1186A.
Table T9. Characteristic remanent magnetic direction, natural remanent magnetization intensity, 
median destructive field, magnetic susceptibility, and Koenigsberger ratio for selected basalt 
pieces, Hole 1186A.

Table T10. Paleomagnetic Units I–VIII.
Table T11. Number of samples, mean inclination, and corresponding 95% confidence angle, 
precision parameter, paleolatitude (95% confidence interval), magnetic chron, and approximate 
age for selected sediment cores and all basalts, Hole 1186A.

Table T12. Index properties data, Site 1186.
Table T13. P-wave velocity measured using the Hamilton Frame, Hole 1186A.
Table T14. Thermal conductivity values, Site 1186.
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Chapter 7, Site 1187
Table T1. Coring summary, Hole 1187A.

Table T2. Expanded coring summary, Hole 1187A. 
Table T3. List of planktonic foraminifer and calcareous nannofossil occurrences and age assignments 
in sediments, Site 1187.

Table T5. Whole-rock compositions of basalt samples, Hole 1187A.
Table T6. Characteristic remanent magnetization direction, natural remanent magnetization 
intensity, median destructive field, magnetic susceptibility, and Koenigsberger ratio for selected 
basalt pieces.

Table T7. Index properties data, Hole 1187A.
Table T8. P-wave velocity measured using the contact probe system, Hole 1187A.
Table T9. Thermal conductivity values, Hole 1187A.

Smear Slide Data Tables
Site 1183 smear slide table.
Site 1184 smear slide table.
Site 1185 smear slide table.
Site 1186 smear slide table.
Site 1187 smear slide table.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
This CD-ROM contains author-prepared supplementary material that was prepared during Leg 192 
but not cited in the Initial Reports volume. Supplementary material files must be viewed with 
appropriate software and are located in the SUPP_MAT directory. A complete listing of the files follows.

PIECE LOGS

These Excel 97/98 spreadsheet files contain the piece logs for Sites 1183, 1185, 1186, and 1187.

PIECELOG
PL_1183.XLS: Site 1183 log.
PL_1185A.XLS: Hole 1185A log.
PL_1185B.XLS: Hole 1185B log.
PL_1186.XLS: Site 1186 log.

PL_1187.XLS: Site 1187 log.

PHOTOMICROGRAPHS

The digital photomicrograph files are in PDF format. The logs are in Excel 97/98 format. The 
photomicrograph logs describe the photomicrographs listed below and the photomicrographs 
presented in the Initial Reports volume.

PHOTOMIC
IGPHOTO (Igneous photomicrographs)

IG_LOG.XLS: Igneous photomicrograph log 
for Sites 1183–1187.

1184A043.PDF
1184A079.PDF
1184A149.PDF
1185A095.PDF
1185A096.PDF

1185A097.PDF
1185A098.PDF
1185A099.PDF
1185A100.PDF
1185A101.PDF
1185A102.PDF
1185A103.PDF
1185A104.PDF
1185A105.PDF
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1185A106.PDF
1185A107.PDF
1185A108.PDF
1185A109.PDF
1185A110.PDF
1185A111.PDF
1185A112.PDF
1185A113.PDF
1185A114.PDF
1185A115.PDF
1185A116.PDF
1185A123.PDF
1185B180.PDF
1185B181.PDF

SEDPHOTO (Sedimentary photomicrographs)
1183A

1183_LOG.XLS: Hole 1183A sedimentary 
photomicrograph log.

1183S42.PDF
1183S43.PDF
1183S44.PDF
1183S45.PDF
1183S46.PDF
1183S47.PDF
1183S48.PDF
1183S49.PDF
1183S50.PDF
1183S51.PDF
1185B182.PDF
1185B183.PDF
1185B195.PDF
1185B197.PDF
1185B198.PDF
1185B200.PDF
1185B205.PDF
1186A232.PDF
1186A234.PDF
1186A247.PDF
1187A238.PDF
1187A249.PDF
1187A250.PDF
1187A251.PDF
1187A257.PDF
1187A258.PDF

1183S52.PDF
1183S53.PDF
1183S54.PDF
1183S55.PDF
1183S56.PDF
1183S57.PDF
1183S58.PDF
1183S59.PDF
1183S60.PDF
1183S61.PDF
1183S62.PDF
1183S63.PDF
1183S64.PDF
1183S65.PDF
1183S66.PDF
1183S67.PDF
1183S68.PDF
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1183S69.PDF
1183S70.PDF
1183S71.PDF
1183S93.PDF
1183S94.PDF
1183S95.PDF
1183S96.PDF
1183S97.PDF
1183S98.PDF
1183S99.PDF
1183S100.PDF
1183S101.PDF
1183S102.PDF
1183S103.PDF

1183S122.PDF
1183S123.PDF
1183S124.PDF
1183S125.PDF
1183S126.PDF
1183S127.PDF
1183S128.PDF
1183S129.PDF
1183S130.PDF
1183S131.PDF
1183S132.PDF
1183S133.PDF
1183S134.PDF
1183S135.PDF
1183S104.PDF
1183S105.PDF
1183S107.PDF
1183S108.PDF
1183S109.PDF
1183S110.PDF
1183S111.PDF
1183S112.PDF
1183S113.PDF
1183S114.PDF
1183S115.PDF
1183S116.PDF
1183S117.PDF
1183S118.PDF
1183S119.PDF
1183S120.PDF
1183S121.PDF

1183S136.PDF
1183S137.PDF
1183S138.PDF
1183S139.PDF
1183S140.PDF
1183S141.PDF
1183S142.PDF
1183S143.PDF

1185A
1185_LOG.XLS: Hole 1185A sedimentary 

photomicrograph log.
1185S6.PDF
1185S7.PDF
1185S8.PDF
1185S9.PDF
1185S10.PDF
1185S11.PDF
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1185S12.PDF
1186A

1186_LOG.XLS: Hole 1186A sedimentary 
photomicrograph log.
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 192 Site Map

ODP Map (Legs 100–192)

DSDP Map (Legs 1–96)
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RELATED LEG DATA
DOWNHOLE LOGGING AND CORE DATA 

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 192 
depth-shifted and processed downhole logging data and shipboard core logging data (color 
reflectance, gamma-ray attenuation bulk density, magnetic susceptibility, moisture and density, and 
natural gamma radiation). The downhole logging data are provided by the Borehole Research Group 
at the Lamont-Doherty Earth Observatory, Wireline Logging Operator for ODP.

Most of the logging and core data included on this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory, Columbia 
University, Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-3182; E-mail: 
borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–173 and 174B. The indexes are contained in the 
directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes can 
be searched individually or collectively.
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CD-ROM DIRECTORY STRUCTURE 

ACROREAD
(Acrobat Reader 4.0.5 installation 
software and instructions for 
different platforms)

192IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR192_01.PDF (Leg 192 Summary)VOLUME
(Leg 192 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(Information about the volume CD-ROM in ASCII format)

MAPS
(Drilling location maps)

ODPMAP.PDF
(ODP map, Legs 100 through 192)

CHAPTERS
(Volume chapters)

192_MAP.PDF
(Leg 192 site map)

IR192_02.PDF (Explanatory Notes)

IR192_03.PDF (Site 1183)

IR192_04.PDF (Site 1184)

IR192_05.PDF (Site 1185)

IR192_06.PDF (Site 1186)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(ASCII versions of coring summary,
biostratigraphy, geochemistry,
paleomagnetism, physical properties,
and smear slide data tables)

IR192_03 (Site 1183 files)

IR192_04 (Site 1184 files)

IR192_05 (Site 1185 files)

(Continued on next page)

INDEX.PDX 
(Acrobat file used to enable Acrobat
Search of the Leg 192 Initial Reports)

COR_1183.PDF (Site 1183)CORES
(Visual core descriptions, smear slide
and thin section data tables, and
digital photomicrograph and
core images)

COR_1184.PDF (Site 1184)

COR_1185.PDF (Site 1185)

PHOTOMIC (PDF files of photomicrographs)

IR192_07.PDF (Site 1187)

COR_1186.PDF (Site 1186)

COR_1187.PDF (Site 1187)

IMAGES (PDF files of core images)

S_SLIDES (Smear slides from Sites 1183
through 1187)

README.TXT

IR192_07 (Site 1187 files)

IR192_06 (Site 1186 files)

MAC

UNIX

WINDOWS
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 173NDX.PDF and 
174BNDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

SUPP_MAT
(Supplementary Material)

PIECELOG
(Site 1183, 1185, 1186, and 1187
piece logs)

PL_1183.XLS (Site 1183 log)

PL_1185A.XLS (Hole 1185A log)

PHOTOMIC
(PDF files of additional
photomicrographs and digital
photomicrograph logs)

IGPHOTO (PDF files of igneous photomicrographs)

SEDPHOTO (PDF files of sedimentary
photomicrographs)

PL_1185B.XLS (Hole 1185B log)

PL_1186.XLS (Site 1186 log)

PL_1187.XLS (Site 1187 log)
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